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MCQ for FINALTERM EXAMINATION
CS408- Human Computer Interaction

Question No: 1 (Marks: 1) - Please choose one

Persona is not context specific, so it can be reused easily.

» True

» False

Question No: 2 (Marks: 1) - Please choose one

In an email application configuring a new email server is a key path activity.
» True

» False

Question No: 3 (Marks: 1) - Please choose one

are perhaps the least-documented patterns, but they are
nonetheless in widespread use.

» Postural

» Structural
» Behavioral
» Mnemonic

Question No: 4 (Marks: 1) - Please choose one

The way people carry out an activity in the real world is same as how it may be
observed in the laboratory

» True

» False

Question No: 5 (Marks: 1) - Please choose one

Engineering a user interface involves a quantitative engineering style of working
in which measurements are used to judge the quality of interface. Hence
is appropriate.

» Usability testing

» Field study
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» Predictive evaluation

» DECIDE framework

Question No: 6 (Marks: 1) - Please choose one

Exploring how children talk together in order to see if an innovative new
groupware product would help them to be more engaged would probably be better
informed by a

» Usability testing
» Field study
» Predictive evaluation

» DECIDE framework

Question No: 7 ( Marks: 1) = Please choose one

Beneath the surface is the of the site: the placement of buttons,
tabs, photos, and blocks of text.

» Surface
» Structure
» Skeleton

» Scope

Question No: 8 (Marks: 1) - Please choose one

Roughly percent of the male population has some degree of color
blindness.

> 10
> 20
» 30
> 40

Question No: 9 (Marks: 1) - Please choose one

are individual and isolated regions within display that can be
selected by the user to invoke specific operations.
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» Buttons
» Pointers
» Menus

» Windows

Question No: 10 ( Marks: 1) - Please choose one

The function came into being as the result of the implementation model
for undo

» Redo
» Undo
» Repeat

» Delete

Question No: 11 ( Marks: 1) -Please chooseone

If the user wants to place the document somewhere in the file system
hierarchy, he can request this function from the menu.

» Explicitly
» Implicitly
» Habitually

» Properly

Question No: 12 (Marks: 1) - Please choose one

Design of user interfaces does not entirely aesthetic concerns, but
rather it places such' concerns within the constraints of a
framework.

» Include, Functional
» Exclude, Functional
» Include, Non-Functional
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» Exclude, Non-Functional

Question No: 13 (Marks: 1) - Please choose one

When developing , plan to keep them short, straightforward and
avoid asking too many.

» Videos
» Documentation
» Interview questions

» Contextual enquiry

Question No: 14 ( Marks: 1) - Please choose one

Conventional wisdom says that tell the user when he has made some
mistake.

» Program crash
» System stuck
» Error messages
» Metadata

Question No: 15 ( Marks: 1) - Please choose one

People frequently counter the idea of feedback with arguments that
users don't like it

» Audible
» Video
» Walkthroughs

» Questions

Question No: 16 (Marks: 1) - Please choose one

environments are environments that are user and context aware.
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» Non-attentive
» Visual

» Sensing
> Attentive

Question No: 17 (Marks: 1) - Please choose one

User personas that are not primary or secondary are personas.

» Served

» Negative

» Customer

» Supplemental

Question No: 18 ( Marks: 1) - Please choose one

Which of the following is the comparison of what happened in the world with
what we wanted to happen?

» Action
» Evaluation

» Execution
» None of these

Question No: 19 (Marks: 1) - Please choose one

The size and shape of a compact disk, is a type of constraint.
» Physical
» Logical
» Cultural
» None of these

Question No: 20 ( Marks: 1) - Please choose one

Research can tell you about what, how, many and why in rich,

multivariate detail.

» Quantitative

» Qualitative
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» SME
» None of these

Question No: 21 (Marks: 1) - Please choose one

is the least technical way of collecting data, but it can be
difficult and tiring to write and observe at the same time.

» Audio recording.
» Taking notes.

» Observation
» Video

Question No: 22 (Marks: 1) - Please choose one

Panes, frames and other containers on screen is a kind of
» Functional and data elements

» View
» Input method
» None of the given

Question No: 23 (Marks: 1) - Please choose one

is particularly useful early in design. It is excellent technique to
use with the prototype, because it provides a wealth of diagnostic information.

» Co-discovery

» Active intervention
» Splendid research
» None of the given

Question No: 24 ( Marks: 1) - Please choose one

Information sites with daily-updated information will naturally attract
users more than a monthly-updated site.

» Repeat

» Infrequent
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» Nonuser
» None of the given

Question No: 25 (Marks: 1) - Please choose one

b

Evaluations done during design to check that product continues to meet users
needs are known as evaluation.
» Formative

» Summative
» Relative

» None of the given

Question No: 26 (Marks: 1) - Please choose one

frequent your primarypersonas access the site,

transient a stance the site needs to take (respectively).
» More, Less
» [ ess, more
» Less, less
» None of the given

Question No: 10 ( Marks: 1) - Please choose one
suggests identifying goals and questions first before selecting

techniques for the study

» RVM model

» DECIDE framework

» Usability testing

» Field study
Question No: 3 (Marks: 1) - Please choose one
applications are great platforms for creating an
environment rich, in visual feedback for the user.

» Sovereign

» Transient

» Auxiliary

» Daemonic

Question No: 4 (Marks: 1) - Please choose one
is the process of selecting things to concentrate on, at a point in
time, from the range of possibilities available.
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» Perception and recognition
> Attention
» Learning
» None of these
Question No: 1 (Marks: 1) - Please choose one
1s like the building name for a website.
» Site ID
» Navigation
» Section
» None of the given

Question No: 3 (Marks: 1) - Please choose one
1s the extra work that satisfies the needs to achieve our objective.
» Evaluation
» Excise
» Testing
» None of the given

Question No: 4 (Marks: 1) -Please choose one
Panes, frames and other containers on screen is a kind of
» Functional and data elements
» View
» Input method
» None of the given

Question No: 5 (Marks: 1) - Please choose one
Which of the following is least likely to be revealed by a paper prototype?
» Your users don’t know the term algorithm
» Toolbar buttons are too small to press.

» The Help menu isn’t in the right place.

» None of the given

Question No: 6 (Marks: 1) - Please choose one

is the least technical way of collecting data, but it can be
difficult and tiring to write and observe at the same time.

» Audio recording.

» Taking notes.

» Observation

» Video

Question No: 7 (Marks: 1) - Please choose one

Every page within a site should contain a brief that accurately
describes the content of the page.

» Site ID.

» Header

» Local Navigation.
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» Search button

Question No: 8 (Marks: 1) - Please choose one
applications are great platforms for creating an
environment rich, in visual feedback for the user.
» Sovereign
» Transient
» Auxiliary
» Daemonic

Question No: 9 (Marks: 1) - Please choose one

What is the fifth step in defining the requirements with respect to persona-
based design?

» Brainstorming.

» Identifying persona expectations.

» Constructing the context scenario.

» Identifying needs

Question No: 10 (Marks: 1) - Please choose one

You can load a VCR tape the right way because of
» Physical constraints

» Logical constraints

» Cultural constraints

» None of these

Question No: 11 (Marks: 1) - Please choose one
are unintentional while occur through conscious

deliberation.

» Slips, mistakes

» Errors, slips

> Mistakes, errors http://www.vustudents.net
» Mistakes, slips

Question No: 12 (Marks: 1) - Please choose one
What is the main strength of the Problem Space Framework as a model of human
problem solving?
P It operates within the constraints of the human processing system
» None of these
» It explains what is involved in insight
» It allows ill-defined problems to be solved

Question No: 13 (Marks: 1) - Please choose one

is the process of selecting things to concentrate on, at a point in
time, from the range of possibilities available.
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» Perception and recognition
P> Attention

» Learning

» None of these

Question No: 14 (Marks: 1) - Please choose one

Over a short period of time, we find it easier to remember the string of numbers
“404 894 6743" because

» Numbers are easier to remember than arbitrary characters.

» The grouping of the numbers is significant

» Ten numbers is not that many to have to remember from working memory.
» None of these

Question No: 16 (Marks: 1) - Please choose one
involves watching and listening to users.

» Observation

» Evaluation

» Qualitative research

» Interaction

Question No: 17 ( Marks: 1) - Please choose one

The name of the document should be shown on the application’s
A. Menu bar

B. Title bar

C. Title bar and menu bar

D. Not Title bar and not menu bar

Question No: 18 ( Marks: 1) - Please choose one

The established standard suite of for most applications consists of the Save
As dialog, the Save Changes dialog, and the Open File dialog.

» OS management

» File management

» Data management

» Application management

Question No: 19 (Marks: 1) - Please choose one
is the remarkable facility that lets us reverse a previous action.
» Redo
» Undo
» Repeat
» Delete

Question No: 20 ( Marks: 1) - Please choose one
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Explanatory undo is, generally, a much more pleasant feature than
» Single Undo

» Multiple undo

» Blind undo

» Incremental Undo

Question No: 21 (Marks: 1) - Please choose one
Browser Title always contains the word ’

» Home

» Default

» Error

» Browser

Question No: 22 (Marks: 1) - Please choose one

Interpretation inquiry, according to Beyer and Holtzblatt, is based on a master-
apprentice model of learning.

» True

» False

Question No: 25 (Marks: 1) - Please choose one

are the street signs of the web.

» Site [Ds
» Home pages
» Page Names
» Sections

Question No: 26 (Marks: 1) - Please choose one
1s not like other pages; it has different burdens to bear, different

promises to keep.

» Homepage

» Form

» Navigation bar
» Sections

Question No: 28 (Marks: 1) - Please choose one
Number of keystrokes is work.

» Logical

» Mnemonic

» Physical

» Structural

Question No: 29 (Marks: 1) - Please choose one
Recalling password is work.
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» Logical
» Mnemonic
» Physical
» Structural

Question No: 30 (Marks: 1) - Please choose one

The persona is not an actual user of the product, but is indirectly affected by it and
its use refers to persona

» Primary
» Secondary
» Served

» Negative

Question No: 31 (Marks: 1) - Please choose one
is a powerful, multipurpese design tool that helps overcome
several problems that currently plague the development of digital products.
Scenario
Persona
Prototype

Question No: 32 (Marks: 1) - Please choose one

The difference between the intentions and allowable actions is the :
» Gulf of Execution
» GQGulf of Evaluation
» None of these

Question No: 33 (Marks: 1) - Please choose one
Attention is the process of selecting things to concentrate on, at a point in
time, from the ran o

» Possibilities available

» Time Available

» None of these

Question No: 34 (Marks: 1) - Please choose one
The goals of HCI are :

» Usability and User Experience

» Learn ability and Comfort

» Tasks and Goals.

Question No: 35 (Marks: 1) - Please choose one
While there can be wide variations in where and how you conduct a usability
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test, every usability test shares:
» Three Characteristics
» Five Characteristics
» Seven Characteristics

Question No: 36 (Marks: 1) - Please choose one
WYSIWYG stands for .

> Where you see is where you get

» What you see is what you get

> When you see it when you get

Question No: 37 (Marks: 1) - Please choose one
is proportional to the amplitude of the sound.

> Pitch
> Loudness
> Timber

Question No: 49 (Marks: 1) - Please choose one

If the user wants to place the document somewhere in the file system
hierarchy, he can request this function from the menu.

» Explicitly
» Implicitly
» Habitually
» Properly

Question No: 18 (Marks: 1) - Please choose one
Which of the following is the comparison of what happened in the world with
what we wanted to happen?

» Action
» Evaluation

» Execution
» None of these

Question No: 25 (Marks: 1) - Please choose one
Evaluations done during design to check that product continues to meet users’
needs are known as evaluation.

» Formative

» Summative

» Relative

» None of the given

Which of the given statements correctly defines effectiveness in terms of one
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of the usability goals?

» It is a very general goal and refers to how good a system at doing what it is
suppose to do.

» It refers to the way a system supports users in carrying out their tasks.

» It involves protecting the users from dangerous conditions

» It involves protecting the users from undesired situations

Question # 2 of 10 (Start time: 07:45:44 PM ) Total Marks: 1
Which of the following is not a secondary color?

Green Orange Purple Blue

Question # 3 of 10 ( Start time: 07:46:45 PM ) Total Marks: 1
Which of the following device can not be useful for a visually impaired person?

» atypical keyboard
» atypical monitor
» atypical speaker
» atypical processor

Question # 4 of 10 ( Start time: 07:48:24 PM ) Total Marks: 1
Which of the following requires less cognitive effort than others?

» Listening

» speaking

» hearing

» None of the given

Question # 5 of 10 ( Start time: 07:49:20 PM ) Total Marks: 1
We are deficient in our development , not in our development
(respectively).

» Process, Tools
» Tools, Process
» Tools, Methodology
» None of these

Question # 6 of 10 ( Start time: 07:50:34 PM ) Total Marks: 1
Which of the following is not true regarding “cones’?

» atype of receptor in eye more sensitive to light
» different types of cones are sensitive to different wavelengths of light

» eye has approximately 6 million cones

Question # 7 of 10 ( Start time: 07:51:35 PM ) Total Marks: 1
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Which of the following does not count as one of the advantages of computers?

» Computers are enabling new discoveries

» Leading to efficiencies

» Making our life convenient

> Depending so much on computers may give fatal results

Question # 8 of 10 ( Start time: 07:52:26 PM ) Total Marks: 1
The gulf of execution refers to

The user’s difficulty in understanding the feedback from the system
The system’s difficulty in presenting information in the output language
The system’s difficulty in converting an input expression into the
correct system state transition

The user’s difficulty in formulating and articulating an intention to the
system

>
>
>
>

Question # 10 of 10 ( Start time: 07:55:10 PM ) Total Marks: 1
Which of the following is not true?

» Utility refers to the functionality'of a system

» Usability is concerned with adding complexity to the system

» Usability is concerned with making $ystems:easy to use

» Poorly designed computer system can be extremely annoying to users

Question # 1 of 10 ( Start time: 09:41:29 PM ) Total Marks: 1
The command line interface is used because

» It is easy to understand

» It is demanded by DOS

» It is offered by Unix systems
» It is powerful and flexible

Question # 2 of 10 ( Start time: 09:42:00 PM ) Total Marks: 1
Which of the given statements correctly defines effectiveness in terms of one of
the usability goals?

» It is a very general goal and refers to how good a system at doing what it is
suppose to do.

It refers to the way a system supports users in carrying out their tasks.

It involves protecting the users from dangerous conditions

It involves protecting the users from undesired situations

YV VYV

Question # 4 of 10 ( Start time: 09:43:38 PM ) Total Marks: 1
Which of the following is concerned primarily with understanding human
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behavior and the mental processes that underlie it?

» Psychology

» Sociology

» Statistics

» Computer Science

Question # 5 of 10 ( Start time: 09:44:09 PM ) Total Marks: 1
HCI deals with

» Design of interactive system only

» Evaluation of interactive system only

» Implementation of interactive system only
» All of the given choices

Question # 7 of 10 ( Start time: 09:45:02 PM ) Total Marks: 1
Human beings interact with outside weorld, using their

input channels
output channels
sense of sight
All of the given

YVVVY

Question # 9 of 10 ( Start time: 09:45:56 PM ) Total Marks: 1
Visually impaired persons can interact with outside world using their

» sense of sightsense of hearing
» both sense of touch and sense of hearing
» sense of touch

Question # 10 of 10 ( Start time: 09:46:18 PM ) Total Marks: 1
Which of the given statements correctly defines efficiency in terms of one of the
usability goals?

» It is avery general goal and refers to how good a system at doing what it is
suppose to do.

It refers to the way a system supports users in carrying out their tasks.

It involves protecting the users from dangerous conditions

It involves protecting the users from undesired situations

YV V

Question No:7 (Marks:1)
plays a role to bridge up the gape between the interfaces of
machines and human understanding.

» Human

» Computer
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» Human Computer Interaction
» None of these

Question No: 8 (Marks:1)
The persona’s needs are sufficiently unique to require a distinct interface
form and behavior is type of Persona.

» Primary
» Secondary
» Supplement
» Negative
Question No:9 (Marks:1)
A is usually a collection.of icons those are reminiscent of the
purpose of the various modes.
» Button
» Pointer
> Palette
» Title bar
Question No: 10 (Marks:1)
The persona is not an actual user of the product, but is indirectly affected
by it and its use refers to persona
» Primary
» Secondary
» Served
» Negative
Question No: 11 (Marks: 1)

During phase, usage and workflow patterns discovered
through
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» Modeling, analysis
» Analysis, modeling
» Testing, modeling
» Testing, Analysis

Question No: 12 (Marks: 1)
The Usability Engineering lifecycle was proposed by

» Deborah Mayhew
» Webster
» Barry Boehm.
» Hartson.
Question No: 13 (Marks:1)
Waterfall model is basically a model in which each step must
be completed before the next step can be started
» Incremental
» Linear
» Iterative
» Analytical

Question # 1 of 10 ( Start time: 04:26:12 PM ) Total Marks: 1
and are the same things

Excise and Navigation

Excise and Testing

Excise and Evaluation

All of the given

Quiz Start Time: 04:26 PM Time Left 89
sec(s)

Question # 2 of 10 ( Start time: 04:27:25 PM ) Total Marks: 1
Scenario content and context are derived from information gathered during the
phase and analyzed during the phase

(respectively)
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Usability testing works for

» Research, modeling
» Modeling, implementation
» Research, implementation
» Modeling,Research

Question # 3 of 10 ( Start time: 04:28:21 PM ) Total Marks: 1

» Software products
» Hardware products
» All products

None of the given

Question # 4 of 10 ( Start time: 04:29:09 PM ) Total Marks: 1
What do you enjoy most about your job (or lifestyle) is an example of

» Avoidance
» Motivation
» Exceptions
» Attitude-oriented questions

Question # 5 of 10 ( Start time: 04:29:46 PM ) Total Marks: 1

represents the Early-phase of ethnographic interviews.

» Clarify user roles and behaviors.
» Confirm patterns of use.

» Clarifying questions.

» Focused on domain knowledge.

Question # 7 of 10 ( Start time: 04:31:56 PM ) Total Marks: 1
There can only be one persona per interface for a product

» Primary
» Secondary
» Supplemental
» Customer

Question # 8 of 10 ( Start time: 04:32:40 PM ) Total Marks: 1

capture the non-verbal dialogue between artifact and user over

time.

» Persona
> Scenario
» Dialogue
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» Design model

Question # 1 of 10 ( Start time: 04:35:42 PM ) Total Marks: 1
Number of keystrokes is the type of work.

Logical
Mnemonic
Physical
Structural

Question # 2 of 10 ( Start time: 04:36:46 PM ) Total Marks: 1
What are the most common things you do with the product is a type of

» Goal-oriented question.

» System-oriented question.
» Workflow-oriented question.
» Attitude-oriented question.

Question # 3 of 10 ( Start time: 04:37:24 PM ) Total Marks: 1
Desktop applications fit into categories of posture.

» Two
» Four
» Five
» Three

Question # 5 of 10 ( Start time: 04:38:32 PM ) Total Marks: 1
Goal-oriented context scenarios are task-oriented than key path
scenario

» Less
» Alike
> More
» None of the given

Question # 6 of 10 ( Start time: 04:39:55 PM ) Total Marks: 1
patterns can be applied at the conceptual level.

> Postural

» Structural
» Behavioral
» Mnemonic

Question # 7 of 10 ( Start time: 04:40:14 PM ) Total Marks: 1
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represent the user’s expectations of the tangible outcomes of using
a specific product.

» Non-user goals
» End goals

» Experience goals
» Life goals

Question # 8 of 10 ( Start time: 04:40:47 PM ) Total Marks: 1
Usability testing works for

» Software products
» Hardware products
» All products

Question # 10 of 10 ( Start time: 04:41:49 PM ) Total Marks: 1
If the user requires access via a navigational portal relatively infrequently, the
appropriate posture is

» Sovereign
» Transient
» Temporary
» None of the given

Question # 4 of 10 ( Start time: 05:13:09 PM ) Total Marks: 1
The phase sets the stage for the core of the design effort

» Requirement definition
» Modeling

» Implementation

» None of the given

Question # 5 of 10 ( Start time: 05:14:12 PM ) Total Marks: 1
If the product is new then time is usually invested in
market research.

» Less
> Less
» More
> None of the given

Question # 8 of 10 ( Start time: 05:17:50 PM ) Total Marks: 1
Which of the following is least likely to be revealed by a paper prototype?
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» Your users don’'t know the term algorithm
» Toolbar buttons are too small to press.
» The Help menu isn’t in the right place.

» None of the given

Question # 9 of 10 ( Start time: 05:19:06 PM ) Total Marks: 1
and are the same things

» Excise and Navigation
» Excise and Testing

» Excise and Evaluation
> All of the given

Question # 10 of 10 ( Start time: 05:20:31 PM ) Total Marks: 1
is needed to check that users can use the product and

like it.

» Coding

» Evaluation

> Guideline

» None of the given

Question No: 9 (Marks: 1) - Please choose one

What is the fifth step in defining the requirements with respect to persona-
based design?

» Brainstorming.
» Identifying persona expectations.
» Constructing the context scenario.
» Identifying needs
Question No: 12 ( Marks: 1) - Please choose one

What is the main strength of the Problem Space Framework as a model of human
problem solving?

P It operates within the constraints of the human processing system
P It explains what is involved in insight

» It allows ill-defined problems to be solved

» None of these

Question No: 14 ( Marks: 1) - Please choose one

Over a short period of time, we find it easier to remember the string of numbers
"404 894 6743" because

» Numbers are easier to remember than arbitrary characters.
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» The grouping of the numbers is significant
» Ten numbers is not that many to have to remember from working memory.
» None of these

Question No: 18 (Marks: 1) - Please choose one

The established standard suite of for most applications consists of the
Save As dialog, the Save Changes dialog, and the Open File dialog.

» OS management

» File management

» Data management

» Application management

Question No: 20 ( Marks: 1) -Please choose one

Explanatory undo is, generally, a much more pleasant feature than

» Single Undo

» Multiple undo

» Blind undo

» Incremental Undo

Question No: 21 ( Marks: 1) - Please choose one

Browser Title always contains the word * ’

» Home
» Default
» Error
» Browser

Question No: 22 ( Marks: 1) - Please choose one

Interpretation inquiry, according to Beyer and Holtzblatt, is based on a master-
apprentice model of learning.

» True
» False

Question No: 25 (Marks: 1) - Please choose one

are the street signs of the web.
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» Home pages

» Page Names
P Sections

Question No: 26 (Marks: 1) - Please choose one
1s not like other pages; it has different burdens to bear, different

promises to keep.

» Homepage

» Form

» Navigation bar
» Sections

Question No: 27 (Marks: 1) - Please choose one
The suggests identifying goals and questions first before selecting
techniques for the study

» RVM model

» DECIDE framework

» Usability testing

» Field study

Question No: 29 ( Marks: 1) - Please choose one
Recalling password is work.

» Logical

» Mnemonic

» Physical

» Structural

Question No: 30 ( Marks: 1) - Please choose one
The persona is not an actual user of the product, but is indirectly affected by it and
its use refers to persona

» Primary
» Secondary
> Served

» Negative

Question _ (Marks: 1) - Please choose one
To make an appointment you need to see a calendar and possibly
contacts you might incorporate all these together, due to :
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Form factor
Input method
View

None of the given

Question __ (Marks: 1) - Please choose one
What is the fourth step in defining the requirements with respect to
persona-based design?

Creating problem and vision statement.
Brainstorming.

Identifying persona expectations.
Constructing the context scenario.

Question  (Marks: 1) - Please choose one
Navigation represents excise except in

Web
Games
Windows
Menus

Question _ (Marks: 1) - Please.choose one
If the user requires access via a navigational portal relatively infrequently,
the appropriate posture is

Sovereign
Transient
Temporary

None of the given

Question _ (Marks: 1) - Please choose one

Because the user's interaction with a program dominates his
session at the computer, the program shouldn't be afraid to take as much
screen real estate as possible.

Transient
Auxiliary
Sovereign
Daemonic

Question _ (Marks: 1) - Please choose one
Programs that are best used full-screen, monopolizing the user’s attention
for long periods of time, are posture application.
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Transient
Sovereign
Auxiliary

None of the given

Question ( Marks: 1) - Please choose one
Evaluations done during design to check that product continues to meet
users’ needs are known as evaluation.

Formative
Summative
Relative

None of the given

Question _ (Marks: 1) - Please choose one
What is the second step in defining the requirements with respect to
persona-based design?

Brainstorming

Creating problem and vision statement.
Identifying persona expectations.
Constructing the context scenario.

Question  (Marks: 1) - Please choose one
patterns can be applied at the conceptual level.

Postural
Structural
Behavioral
Mnemonic

Question _ (Marks: 1) - Please choose one
Overviews serve a similar purpose to in an interface.

Navigation
Excise
Signposts

None of the given

Question ( Marks: 1) - Please choose one
personas address the needs of customers, not end users.
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Served
Negative
Customer
Supplemental

Question _ (Marks: 1) - Please choose one
Navigation represents excise except in

Web
Games
Windows
Menus

Question  (Marks: 1) - Please choose one

Desktop applications fit into categories of posture.
Two

Four

Five

Three

Question _ (Marks: 1) - Please choose one

Scenario content and context are derived from information gathered during
the phase and analyzed during the phase
(respectively)

Research, modeling
Modeling, implementation
Research, implementation

Modeling, Research

Question ( Marks: 1) - Please choose one
Evaluations done during design to check that product continues to meet
users’ needs are known as evaluation.

Formative
Summative
Relative

None of the given

Question _ (Marks: 1) - Please choose one
represent the user’s expectations of the tangible outcomes of
using a specific product.

Non-user goals
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End goals
Experience goals

Life goals http://www.vustudents.net
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